Department of .
‘\M HUMAN SERVICES System Checks Guidance for Intake

WISE

To access the WISE home page, click
https://intra.dhs.state.ia.us/im wise/home/dashboard

Welcome SR

e Worker Information System Exchange S : -
© Desows Good Afternoon FirstName = :
= Userinformenion @ b o
= Caseinformeton @ ., & 3
@  DawmSource

e
We saved your last Q activity

Case number -

State ID -

You can search for person by SSN or SID in the search box indicated below. Click the
looking glass to begin the search.

e Search.. L7
Welcome e [
User
® orane Worker Information System Exchange

© auens Good Afternoon FirstName : 4 2

N [
gyt
@ Dawsource We saved your last Q activity
Case number -
State ID -
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If you don’t have the Social Security Number or State 1D, you can conduct an Advance
Search by clicking the down arrow to the right of the looking glass.

= 1500 NS search... Q v A =

Advance Search

Worker Information System E: & | Firstname
a Last name

Good Afternoon C
Date of birth - mm/dd/yyyy

sea I iividual

We saved your last Q activity
Case number - I 150 |
State ID - |

Advance Search allows a search by first and last name. DOB is not required but can be
used to further refine the search results. To complete an Advance Search, a minimum
of two letters of the first and two letters of the last name are required. This can be
helpful when you are uncertain of the spelling of a name. Remember to look for spelling
variations (i.e., Smith, Smyth or John, Jon, Jonathan).

After completing the applicable entry fields in the Advanced Search, click the green bar
at the bottom of the drop down menu.

Search Individual

A list of search results will be displayed.

24 results found for: "dawn johnson

LIS owomi, JOHNSON  Sociel Secumy Numier - & Sue il Z A oar1 2007
m DAWN  JOHNSON  Sneisl Secimmy Humbier - & % G 1T C 05/30N1954
m DAWN , JOHNSON  Social Secuniy Number -4 Seate 10 5 ]
m DAWN , JOHNSON  Social Seeipey Hismber
[0 oawm . jounson s

. B TUVTRET TYTVT T VTR T hhmbnn S ¥ Toreairs 3 FPPL TV

Select the best option by clicking on the name.
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Selecting a search result will advance the user to the Individual screen in WISE, which
consists of three sections. The top of the Individual screen displays the person’s SSN,
SID, DOB, age, SID, gender, and information about citizenship and identity.

HOME ¥ Individual
Individual

DAWN JOHNSON CITIZENSHIP

Case Individuals

DEmumeE 6 / MARGE BOWRENS

AR By W5 - 9U09800E <HER BOWESLS - 99999000 DAWN IOHNSON - 99999094 s ER MAZT - 55555050
AT 999-99-5999 FI9-99-9995 G505
" a . s
PR T 9999995€
ELEERtE)
s

Individual Cases

D& ?6 / MAIS D5 M757498809 / MARS BORSSS M B/ MARS BOmERS

AZMAGH M 2CN

ELIAS CASE #17099957 et Ll 0B MED Ald Type B0E 0 A Type 308 0w [l 4 Type 308
child w3 fund Code § =

The bottom of the screen shows the open and closed cases associated with the
selected individual. The name at the top of each box represents a head of household on
that case. The blue cases are open cases and the orange cases are closed.

Click the name on blue boxes for a case summary including household members and
their identifying information.
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Case Summary

B2CMX1 @ Review/Recert

Individuals

TORNE BONNENS . $459595F MED [ A ne
555-53-5555

e
mg—m MED At N ne
[EDrm

WINRER BOWINS. - SEERRRC MED FAC A FIP
-t

Bidpe
DAWN IGHNSON - S9909es MiD FAL " ne m
IR

P & ;

Canceted Herver cpaned Pecganes Senisa

AR M - 9Y99S99E MED FAC A ap
TR
L a

(e o]

Cantated [ Pacpenes Dangs

Cancated Forver cpaned Fecgeres Bened

] Navas sganed Paspaned Darees

Copy and paste the Case Summary Page, as displayed above, on all open cases.

The green box provides the contact information for the family. The grey box indicates
the service that is open. The individuals listed indicate the household and who has the
open service(s) in the home.

Go through the individuals; use this information to update household members.

MED FAC FA FIP

CANCELLED NEVER OPENED REOPENED CANCELLED

Status Date Status Date Status Date

0272872015 02/01/20M7 08/31/2015
Aid Type 308 Aid Type 091 Aid Type 091

Status Reason 610 Status Reason 175 Status Reason 087

¢ MED — Medicaid

e FAC - Facility (this will indicate if there is an open waiver) If there is an indication
of an open waiver, then you will be required to complete an IMPA look up.

e FA —Food Assistance
e FIP — Family Investment Program
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* Helpful Hint,on most cases there is a relationships section located on the case
summary page. This can be helpful when determining relationships in the home. This
is not a required look up.

Relationships

M Bl Parent (BiologicalfAdoptive) ER BO 5
-
M B( ] Parent (BiologicalfAdoptive) DAWM JOHNSON
e
T i
ER B & Sibling (full or half, sister/brother-in- DAWN JOHNSON

law, adoptive)

-
& T
M B 5 Parent (Biological/Adoptive) Pl 1 M
. [ ]
T & T
ER Bt Sibling (full or half, sister/brother-in- PEET W Wy

law, adoptive)
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ICAR (lowa Collection and Reporting System)

After logging into NES (Passport) and selecting production, type “ICAR” and press
Enter.

The ICAR Confidentiality and Security screen will display.

Pause/Break to access ICAR.

D479HMBOO IOWA COLLECTION AND REPORTING SYSTEM DATE: 02/08/17
CONFIDENTIALITY & SECURITY TIME: 145842
*x X WARNI NG * x x
THIS SYSTEM MAY CONTAIN U.S5 GOVERNMENT INFORMATION, WHICH IS RESTRICTED TO
AUTHORIZED USERS ONLY. UNAUTHORIZED ACCESS, USE, MISUSE, OR MODIFICATION OF
THIS COMPUTER SYSTEM OR OF THE DATA CONTAINED HEREIN OR IN TRANSIT TO/FROM THIS
SYSTEM CONSTITUTES A VIOLATION OF TITLE 18, UNITED STATES CODE, SECTION 1030,
AND MAY SUBJECT THE INDIVIDUAL TO CRIMINAL AND CIVIL PENALTIES PURSUANT TO
TITLE 26, UNITED STATES CODE, SECTIONS 7213, 7213A (THE TAXPAYER BROWSING
PROTECTION ACT), AND 7431.
THIS SYSTEM AND EQUIPMENT ARE SUBJECT TO MONITORING TO ENSURE PROPER
PERFORMANCE OF APPLICABLE SECURITY FEATURES OR PROCEDURES. SUCH MONITORING MAY
RESULT IN THE ACQUISITION, RECORDING, AND ANALYSIS OF ALL DATA BEING
COMMUNICATED, TRANSMITTED, PROCESSED, OR STORED IN THIS SYSTEM BY A USER.
IF MONITORING REVEALS POSSIBLE EVIDENCE OF CRIMINAL ACTIVITY, SUCH EVIDENCE
MAY BE PROVIDED TO LAW ENFORCEMENT PERSONNEL.

ANYONE USING THIS SYSTEM EXPRESSLY CONSENTS TO SUCH MONITORING.

xxx* PRESS [WM=EIH TO ACCESS ICARxxx*x

The Main Menu screen will display.

To conduct a search, place an “S” on the line next to NAMESRCH and press Enter.

D479HMB1 IOWA COLLECTION AND REPORTING SYSTEM . B2/,08r17
MAIN MENU : :

NAME SERRCH

CHILD CHILD

VCORTORD VIEW COURT ORDERS
VOBLIG VIEW OBLIGATION DETAILS
VCASE VIEW CASE

VOBLGLST VIEW OBLIGATION LIST
VMEDICAL VIEW MEDICAL INFOD
VINSURER VIEW INSURER INFO

1

CASEMTCH IABC/FACS/ICAR CASE MATCH
REFER2 IABC/FACS/ICAR NCP DATA
REFER3 IABC/FACS/ICAR OBL/PMT/INS
AUTOASTM AUTO ASSIGNMENT/TERMINATION
VPAYHIST VIEW PAYMENT HISTORY
VPAYREC VIEW PAY RECORDS

NEXT SCREEN:
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The Name Search screen will display.
Enter SSN if known. If not, enter name of child or parent.

You can also search for a client by Phone Number, Court Order Number, State 1D, or
Similar Sound. (Please choose only one field to complete the search.)

D479HC15 IOWA COLLECTION AND REPORTING SYSTEM DATE: B2/08/17
NAME SEARCH TIME: 15:14:11

NAME (LFMS)..: GRAY ., A

PHONE NUMBER. :

CT ORD NBR...:

STATE ID

SIMILAR SOUND: , , ,
FILTERS:CASE ROLE : CASE STATUS: DOB: WRKR ID:

S0C-SEC PERSON CASE CASE CASE CASE ACT
SEL NAME NUMBER ID NBR NUMBER ST ROLE WRKR OBL

@3=1n0 @E=HIsTSRCH [@§=BACK [=FWD FE-REFRESH [Fg=NAMESRCH INFO ENfIER-SEL DETL
N REE OTES:

PLEASE PRESS TO INQUIRE

Hit Enter and F5 to search.

A list of potential search result matches will display.
Press F8 to forward to the next page of results if necessary.

To inquire on a case, place an “X” on the SEL column next to the potential match.

D478HC15 IOWA COLLECTION AND REPORTING SYSTEM DATE: B2/08/17
NAME SEARCH TIME: 15:20:15

NAME (LFMS)..: GRAY ., A
PHONE NUMBER. :

CT ORD NBR...:

STATE 1ID

SIMILAR SOUND: B ) ,
FILTERS:CASE ROLE : CASE STATUS: DOB: WRKR ID:

S0OC-SEC PERSON CASE CASE CASE CASE ACT
NAME NUMBER ID NBR NUMBER ST ROLE WRKR OBL
AARON C PAYOR DRN3
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A detail screen will provide SSN and DOB.

Verify that these are correct and enter/update demographic information in JARVIS as
needed.

DATSHCOG IOWA COLLECTION AND REPORTING SYSTE DATE: @39/s2
CHILD TIME: 168:12:08%2

DISABILITY: DRI : FVI:

CASE NUMBER = 9999¢ FC IABC CASE MUMBER. .. :

CHILD RESIDES WITH PRAYEE: Y FRACS : OEB UNXREF?:

B/C NO z VERIFY BIRTH INFO: REQT BIRTH CERT:

NAME [LFMS] : DOE = JOHN :

SEX [F/M]1 .. : RELATIONSHIP TO PRAYEE.

=], R — : 988-99-93939 PAYEE LEGAL PRARENT I[¥Y/N

CNTY OF RES “E. : STATE OF BIRTH = = CNTY :

BIRTHDATE : 09 2018 EMAN/DUR END DATE : B9 8- ] LTR:

EMAN/DUR TYPE z EMANSDUR MET [¥Y/N] W 100L. :

STATE FR. . ccc a5 % BIRTH FACILITY : 88-81 FED BEN:

CURRENT RACCT TYPE.: B CURRENT START DATE....: 87 81

NEXT ACCT TYPE....: MEXT START DATE.......: B alo (a]a]0)

FCRU CASE WORKER..: EMAN RETURM: = o]0

GEN CONT. SERVICE.: CORRECTION FLAG: N CORRECTION START D

BORN DUT OF WE CK: ¥ PRATERNITY ESTRBLISHED.: ¥ 1 ivr 518 HOW: PA
COMMENTS: CORRECTION RUN DATE B8 18 2814

F2=ADD, F3=MOD, F4=DEL, F5=INQ, FE=CHILDZ, FFf=BCK, FB=FWR, F3=RFSH, F10=PATAFF, F13=HST

NEXT SCREEMN: NOTES : F12=XREFVER
PERSON IS CROSS REFERENCED. CASE PARTICIPANT AT RISK. PF1B-DETRAILS
Tell ssSL R 5 C 28 CDPYR7TC

Press F6 to access the CHILD2 screen, which will indicate if TPR has occurred.

D479HCA46 IOWA COLLECTION AND REPORTING SYSTEM DATE: B2/08/17
CHILD2 TIME: 15:34:34

CASE NUMBER : EST BY-PASS: TER DATE: 082 23 2015

NAME (LFMS) : MICHAEL -DUANE

PLACEMENT ADDRESS. : DATE OF ADDRESS: 00 00 00
PLCMNT ADDR LINE 2:

CITY/STATE/ZIP

HOME/MAILING ADDR. :

H/M ADDR LINE 2...:

CITY/STATE/ZIP : SOURCE: FACSH
FACS WORKER : FACS CASE WORKER : CSB6& 34
FACS WORKER PHONE. :

FC ENTRY DATE

LENGTH OF STAY

POST LIVING ARRANGEMENT :
COMMENTS :

Copy and Paste the CHILD2 Screen into the ICAR tab under the system checks in
JARVIS.

Note: If a TPR has occurred and there is no known adoption, enter the non-custodial
parent as “TPR Mom” or “TPR Dad” on the collateral screen in JARVIS.
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Hit Pause/Break to navigate back to the Main Menu screen.

To view non-custodial information, place an “S” on the line next to REFER2 and press
Enter.

D479HMB1 IOWA COLLECTION AND REPORTING SYSTEM 1 B2/08/17
MAIN MENU : :

1

NAMESRCH NAME SEARCH
CHILD CHILD
VCORTORD VIEW COURT ORDERS
VOBLIG VIEW OBLIGATION DETAILS
VCASE VIEW CASE
VOBLGLST VIEW OBLIGATION LIST
VMEDICAL VIEW MEDICAL INFO
VINSURER VIEW INSURER INFO
ASEMTICH IABC/FACS/ICAR CASE MATCH
<_S REFER2 > IABC/FACS/ICAR NCP DATA
REFER3 IABC/FACS/ICAR OBL/PMT/INS
AUTOASTM AUTO ASSIGNMENT/TERMINATION
VPAYHIST VIEW PAYMENT HISTORY
VPAYREC VIEW PAY RECORDS

The REFERZ2 screen will provide demographic information on the non-custodial parent.
Review the “Alleged Father” field on the REFER2 Screen to determine if paternity has
been established.

o If “N”: Paternity has been established.

o If “Y”: Paternity has NOT been established. (Enter the non-custodial parent as
“Unknown, ICAR Mom” or “Unknown, ICAR Dad” on the collateral screen in
JARVIS))

D479HR51 I0WA COLLECTION AND REPORTING
-/ ICAR ~-REFERZ - NCP D

ICAR CASE NUMBER: a5 IABC NUMBER......: 08691480009
ALLEGED F¢ R. .t @
GOOD CAUSE. :

* ok ERIEE NON-CUSTODIAL PARENT DATA BELOW %k
\RAY :

: WEIGHT. .: HEIGHT..: 5 109 HAIR. .:
IN PLACEMENT? (FOR FC REFERRALS OMNLY):

:OUNTRY :
000 000 0000

CITY/STATE/ZIP. .:
COMMENTS :
STATES LIVES JES » S S ON BIRTH CERT

F 28 oD, ~REF , E@=BAck, [FJ=FwD, [FE=REFRESH, [FE=1CSC

Copy and Paste the REFER2 screen into ICAR tab under Systems Checks in
JARVIS. If address is listed, enter into JARVIS.

Complete the steps above for all children identified as victim(s) in the household.
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Criminal — lowa Courts Online

1. To begin a criminal case search go to: https://www.iowacourts.state.ia.us

2. Click on “Start a Case Search Here!” hyperlink.

TIowa Courts

Online Search

\ Start A Case Search Here!

For assistance with problems associated with this web page
please contact the ITE Help Desk at 515-281-3703 / 1-800-332-1174 or helpdesk@iowa.gov.

This State of lowa Government computer system is for authorized use only. Use of this system implies consent to monitoring of any and all activities associated with its use. Unauthorized or
improper use of the system may be punishable under applicable sections of the U.S. Code. the State of Iowa Code. and other applicable codes. statutes. and guidelines.

This Web Based Electronic Public Access application requires a 128 bit Cipher Strength on your Internet Explorer. To verify this click on "Help' menu item and select 'About Internet Explorer’. If
1t's less than 128 bat click on link "Update Information' to update Cipher Strength. For assistance with problems associated with this web page please contact the ITE Help Desk at 515-281-5703 /
1-800-332-1174 or helpdesk@iowa.gov.

3. Click “Case Search” under the Trial Court column on the right side of the screen.

Towa Courts Online Search Help
Home
New Search

Search Selection

"Registered users are limited to 1000 searches per calendar day"

Appellate Court Trial Court

Case Search avaitshie to all warsy Case Search avaitsble 1o a0l usersy

Note: Use this search to perform a statewide search on a limited number of fields. The
search results are cases entered into the ICIS System through the end of the last business
day. Once a case is selected from the search results, the case data displayed is up-to-the-
minute as entered by the Clerk of Court.

Payment Search
Note: Use this search to perform a search specificially designed to find a case and then
make a payment on that case. User either 'Case Search’ or 'Advanced Case Search’ for
general queries.
Advanced Case Search avtabie to al usersy Advanced Case Search ®egistersd uses cuty)
Note: This search is used to find up-to-the-minute information as entered by Clerk of

Court. Both the search results and case data are current. A county must be selected to start
an Advanced Search.

Schedule Search @esistasd uses caty)

|~ Selecta Coun_{y_ — v |[ Search |
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4. On the Name Search screen, enter the Last Name and First Name of the person you
are searching for. To narrow the results, you can select the Role as “Defendant” and
Case Type as “Criminal” from the drop down menus.

Name Search Case ID Search Citation Number Search

Name Search

st/Firm Name
Smith

Alias Last/Fim Name Alias First Name Alias Middle Name

Middle Name

First Name

John

Role
DEFENDANT

Second Name

v

Last/Firm Name First Name Middle Name
Alias Last/Firm Name Alias First Name Alias Middle Name

Role
ALL v

County
ALL v

Case Type

\|CRIML\'AL v

5. Type the text in the caption shown in the image for security purposes and click the
“Search” button.

o2 o]

Privacy & Terms

Click here for assistance usmng reCaptcha
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6. The first 200 records that match the specified search criteria will be displayed.

If this is a rejected intake, Copy and Paste the results screen into the CRIMINAL
tab under Systems Checks in JARVIS.

If this is an accepted intake, click on the Case ID number in blue to view a summary
of the case.

|Your query returned more than 200 records.
IA subset of the results (the first 200 records found) is shown below.

ITo get full results, go back to the search screen and narrow your search.

[Case ID Tide Name DOB Role
ST VS JOHN ALLEN SMITH SMITH, JOHN ALLEN 02/15/18 DEFENDANT
* 5T VS JOHN ALLEN SMITH*909*/VICT SMITH. JOHN ALLEN 02/15/18 DEFENDANT
STATE OF [OWA VS SMITH, JOHN ALLEN SMITH., JOHN ALLEN 02/15/18 DEFENDANT
* ST VS JOHN ALLEN SMITH SMITH, JOHN ALLEN 02/15/18 DEFENDANT
ST VS JOHN ALLEN SMITH*209* SMITH, JOHN ALLEN 02/15/19 DEFENDANT
STATE OF [OWA VS SMITH., JOHN ALLEN SMITH. JOHN ALLEN 02/15/18 DEFENDANT

7. On the Case Summary screen, click on “[Criminal Charges/Disposition]”’ located on
the header.

Iowa Courts Online Search He

Search Results Help
Back Print All Pages Home
a =]
Trial Court Case Details New Search
[Summary] Pasties [Long Title] [Eilings] Propertv/Lis Pendens Criminal Charzes/Disposition’ Tudgment/Tiens
Exhibits Financial Bonds Service Retums Traffic Details Rasizter Now!
Summary

Title: ST VS JOHN ALLEN SMITH

Trial Court Case ID Originating County Created Speedy Trial Microfilm Ref
01071 AGCR1%4 BLACK HAWK
Citation Number Disposition Status Disposition Date Reopened Date

GUILTY PLEA/DEFAULT

8. The Charges, Dispositions, and Sentences will be displayed. Copy and Paste the
contents of this screen into the Criminal tab in JARVIS System Checks.
Complete this step for each Case ID linked to the defendant.

Charges, Dispositions. Sentences
SMITH

| L Clurge: | 124 4010508 |
| [ Offese Date | — |
[ | | DPS Number | [BAGORIN 01 ]
| Lidiudication |
| [ Charge: | 124 4010530
1 e
[ | [ Adj Judge | CALLAHAN NATHAN |
[ | | Commens: | |
| fSentence |
| | Charge: | 124 80158 ]
1 | Sentence Date: | p2riz014]
| [ Appea: |
[ | | Facilicy Type: | 3
[ | [ Restitution: a |
| L Lic Hevaked: | v ]
1 [ Fine Amoun:: |
| [ Commen: | I

Sentence
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Note: The user may want to copy and paste all criminal charges for the perpetrator
into a word document and then paste the contents of the word document into the
Criminal tab in JARVIS System Checks.

Case ID Codes:

AG = Criminal

FE = Criminal

SR = Criminal

SW = Criminal

CO = Associate Criminal
CY = Associate Criminal
SM = Associate Criminal
oW = OwI

SP = Civil Equity

PC = Civil Equity

FP = Civil Equity

AR = Criminal

Bl = Birth Records

DE = Death Records
MA = Marriage Records
CD = Civil Dissolution
DA = Domestic Abuse
EQ = Civil Equity

US = Uniform Support
ES = Probate

GC = Probate

TR = Probate

AC = Civil Law

MH = Mental Health

MJ = Mental Health

LA = Civil Law

MS = Probate

CN = Change of Name
AT = Adoptions

| = Civil Infractions

C SC = Small Claims

N = Liens

L JI = Juvenile Court Services
JV = Juvenile Court Services
TJ = Foreign Judgments
JW = Jury

OT = Other Cases

WR = Welfare Reform
NT = License Suspension
FM = CASH DRAWER ADJUST DEFAULT
PM = ICIS

CV = Civil

DR = Civil
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KinderTrack (KT)

1. Access the home page click: http://dhsccmisintra/KinderTrack/

KmdngE?ﬁ."ﬁfh [ senanieer || o || Logout

Refresh

Welcome Amy B Johnson!
(= Intake Your lastlog in was on 1202016 al 211PM

2. To conduct a provider search, click on the Provider tab on the left hand side of the
screen. Once clicked, the provider tab will expand. Click “Search.”

|‘ KinderTg

acks

i

Select: ® Provider (O Contact

[-Intake Business Name: || Phone:
H-Family .
Last Name: I Address:
|<E-Provider
- First Name: | City:

C--Search b} Role: Select =» state: [
Select ==

- Provider Type:
summany Worker. Select == Zip Code: I Ext: I
~Provider :

Languages: Select
~Contacts ProviderNumber:l guag Select =

Missing Documents: [ ]
~Record Checks Status: Select == X
Type of Care l— County of Residence: Select=>
Rypl TaxID or SSH: DHS Service Area: Select>»
aes IWD Region: Select==
~Profile
~MNotices Search Results: Mo items found

~Motes

~Marratives
~Compliance Reports:

RFI

Payments
~Attributes
~Modified Days
~Families
-Contact
[#-Payment

Provider Listing Report Provider Mailing Labels
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3. Enter Business Name OR First and Last Name of the provider. If the name is
unknown, the user can search by provider address. Select the Service Area or
County to drill down results. Press Enter to retrieve a list of search results.

Select: ® Provider () Contact
Business Name: ,W
Last Name: li
First Name: li

Role: Select >
Provider Type: Select=>
Worker: Select>>

Provider Number:

Status: Selects»

Tax ID or SSH:

Phone:
Address:

City:

State:

Zip Code: Ext.:

Languages: Select>>

Missing Documents: [ ]
County of Residence: Select>>
DHS Service Area: Select>»
IWD Region: Select>>

Search Results: 14 items found

Apple Tree (30115

O Canceled
[] |Apple Tree Adventures| akewood (33236) Hoskins, Teresa Active
[ |Apple Tree Adventures-Norwalk-NBA (27966) Hoskins, Teresa Active
[] |Apole Tree Children's Center (283391 Steckelberg, Krysta Active
[] |Apple Tree Chidren's Center (24244) Elston, Tracy Active
[ |Apple Tree Chidren's Center (25879) Sebben, Crystal Active
[ |Apple Tree Children's Center (26555) Ryker, Jennifer Active
[] |Apple Tree Chidren's Center (36701) Torres, Anya Active
[] |Apple Tree Chidren's Eemer (27551) Anderson, Theresa Active
[] |Apole Tree Chidren's i (27653) Hassan, Alesia Active

4. Click on the specific Provider Name from the search result list to view Provider

Information.

Search Results:

Apple Tree Children's Center {(Active) - Record 1 of 1

Effective Date: 10/25/2016

CCA Agreement: Yes

Location: 03

Care Address 1:
Care Address 2:

State: |4

Provider Number: 27551

Vendor Type: Corporation or LLC(C)
Tax ID: 86-0793666

I3#: 00003066975
Business Name: Apple Tree Children's Center
Status: Active
3054 MW B6th St

City: Urbandale

Zip Code: 50322

Service Area:

County:

Phone:

Quality Rating:
Worker:

Mail Address 1:
Mail Address 2:
Mail City:

Mail State:

Mail Zip Code:
Languages:
Flags:

Fax:

Status Info:

Des Moines (Mew
SAS)

Polk
(515) 270-1426

Child Care , Registration
3054 NV 86th St

Urbandale
A
A0322

Remote Attendance

5. Copy and Paste the Provider detail screen (shown above) into the KinderTrack tab
in JARVIS System Checks.
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SOR (lowa Sex Offender Reqgistry)

1. To access the lowa Sex Offender Registry home page, click
http://www.iowasexoffender.com/

. e W
m lowa Sex Offender Registry @‘ EF

This Website is Updated Hourly

As part wmwu\wmcﬂm
Mnmamen

The lowa Sex Offender Registry became law on July 1, 1995 and Is found in Chapter 6324 Code of Towa ot C—

Jacob Wetterfing tﬂw
n or after July 1, 1995, an individual who has been convicted or adjudicated of a criminal offense against a minor, sexual exploitation, or a sexually violent crime or who was on prabation, parole, or work e
release status, or who was incarceratad on or aftar July 1, 1995 is required to register. Registration does includa individuals that have raceived a deferred sentance or deferrad judgments and can include P e e
convictions from other jurisdictions such as other states and/or federal convictions.

was abducted, assaulted and murdered

near his family home, The Act set forth

Quidelines for states to establish sex
offender registry programs.

The information on this website Is provided from the lowa Sex Offender Registry to the public pursuant to lowa Code chapter 692A. The purpose of this information is to allow members of the public 2 means
to protect from who have an offense that requires registration on the Sex Offender Registry. If you see information on our website that is wrong about an offender, please
notify the sheriff of the county where the offender lives. You may also email this agency via the "contact” link located on this website.

The Towa Department of Public Safety, (PS) has a » oy of dedication and service to the ditizens of Iowa and those who visit our state. Since it was first established in 1939, DPS has been the chief stides:1/2 3
law enforcement agency in the State of lowa. DPS Ho 22

The Division of Criminal Investigation, (DCI) was created in 1921 to provide investigative support and expertise to law enforcement agencies across the state. DCI Home

The Dru Sjodin National Sex Offender Public Website, tusvvw) is coordinated by the U.S. Department of Justice. The NSOPR site is a cooperative effort between Jurisdictions hosting public sex offender
registries (“Jurisdictions”) and the federal government. NSOPW Home

There are currently 5,381 registrants listed on this website. This website was last updated today, 02/09/2017, at 02:30:06 pm CST.

The photos below are a few of the registrants who were recently updated.

Click on the “Search” tab. The search screen will display a public notice and
disclaimer. To conduct a person search, type the numbers shown in the caption and
press Submit.

I lowa Sex Offender Registry @ .‘E
o3

Public Notice And User Agreement - Accept To Continue
The information on this site is being provided to the public pursuant to Chapter 6924, Code of Towa, to protect members of the public from potential harm.
You must read and accept this user agreement before you can access some areas of this site,

=== PUBLIC NOTICE AND DISCLAIMER ===

A~
1) This site does not contain the entire list of sex offenders registered in Iowa.
2) Your cemmunicy law enforcement and county sheriff's office are avare that these subjects are in the community.
3) Any actions taken by you against these subjects, including vandalism of property, verbal or written threats of harm or physical assault against these subjects, their families or emplovers
can result in your arrest and prosecution.
4) You must contact your police depariment or Sheriff's office immediately if you believe a crime is being, or will be, committed. If you have any questions regarding this matter, CONTAct your
local police dEPartment or county sheriff's office.
S) Scripted or automated access to this site is denied cutside of the site's rss feed and api. Do not scrape or crawl this site's data, the api offered will assure correctness. v

In order to access some areas of this website you mu: the above. by entering the captcha below. If you are not sure what the numbers are click the reload icon next to the image for a
different image. Visually impaired users can click the aumo button to haar a set of words that can be am’smd mmad of the visual challenge.

F o Tut oy a1
306051

type the numbers shown and press submit

enter the text from the image and click submit
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3. Enter first and last name in the simple search screen. You may search using a full
name or part of a name. If you do not get the results you were expecting, try entering
the first three characters of the name. Enter the zip code (if known) to narrow the

search. Press “Submit Search.”

=4} lowa Sex Offender Registry

m Search Most Wanted Notifications / Registrant Watch - Logon Information

Welcome to the Iowa Sex Offender search pages. There are several ways you can locate registered sex offenders from this
more criteria. The map search lets you locate registrants using geographical data. You can also search using an email addre

= reicoone § v

Simple Search

Last Mame smith

First Name |m

M Also Search Aliases

Postal Code |

[ There are 22 matches for this search.

more options—

Submit Search
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4. A list of search results will display. Click on the Registrant Name from the search
results to view Name, Location, and Convictions.

ey shars slica
. . [T
o Ragruirart 1%

el harre, ey ' againat this parson, incuding vandabem of ¢ vartal or rtten,
bl Erima i Bang. 2 vl ba comummedd. 1F yis bk 8ty uskaicnh riganding this attir, sartsct

~
Mot MICHILLE
¥ r—
S WINES, To, 50309
i

MICHELLE
comartions | IRl
Motica: Ensistins ot multich victims aea Lirted eaga with asch vietin's infarmation,
Sk, ke the G i msmterriz 1 T Vv o Gurentinn, e xl Loy oo, ginas sinh bove
Comsiction Dete | County Age st Offansa Vistim Age Victins Gander
09,11 Assah v corraret sl abscse our1ai0Te Pk 2 0+ 13 [aga] Fernain w

Copy and Paste the conviction(s) located at the bottom of the screen into the
SOR tab in JARVIS system checks.

.| G
Natica: Canvictions with muRipls victims ara Bstad cace with sach victim's informatian,
The link{s) below display the curren t lowa Code, which may not be the Code in existence at the time of conviction. For archived versions of lowa Code, please dick here
Conviction Data 1 county Age at Oftanse Wictin Age Wictim Gendar
09,11 Assault with intent to commit sexual sbuse 08/11/2014 Polk 24 0-13(age) = Femal b
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NSOPW (National Sex Offender Public Website)

1. To access the National Sex Offender Registry home page, click www.nsopw.gov

2. Enter first and last name of the person you are searching for in the “National Sex
Offender Quick Search” section and click Search.

M ART Office of Sex Offender Sentencing, Monitoring,
Apprehending, Registering, and Tracking

THE U.8. DEPARTMENT OF JUSTICE

N s HOME | ABQUT  SEARCH EDUCATION & PREVENTION REGISTRY SITES  FAQ

NSOPW Mobile App

=—— National Sex Offender

Quick Search *

q O "V Enter a first name and last name; then press

Search.

Available ..
The public safety LasT

resource used by over m O | senmitbylocant

60 million people, now
* Registries for all 50 states, the District of

at your fingertips.
Columbia, U.S. territories, and Indian Country.

Public Registry Sites

—Select One— M

NSOPW FAQs

— Select One -- E

>

S

You

Talk With
About Secrets

It's okay not to keep som
promised.

\buse in
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3. The “Conditions of Use” screen will display. Check the box to indicate that you agree
and acknowledge the terms of NSPOW. Type the text in the caption for security
purposes and click “Continue.”

THE U.5. DEPARTMENT OF JUSTICE

N S HOME ABOUT  SEARCH EDUCATION & PREVENTION REGISTRY SITES FAQ

Conditions of Use

This Website is provided as a public service by the U.S. Department of Justice ("the Department”). Using this Website, interested members of the public
have access to and may search participating Jurisdiction Website public information regarding the presence or location of offenders who, in most cases,
have been convicted of sexually violent offenses against adults and children and certain sexual contact and other crimes against victims who are minors.
The public can use this Website to educate themselves about the possible presence of such offenders in their local communities.

Information from the various Jurisdiction Websites is not hosted by the Department, and the Department has neither responsibility for nor control over the
information available for public inspection or search from individual Jurisdiction Websites that are accessible through this Website. The Department does
not guarantee the accuracy, completeness, or timeliness of the information contained in Jurisdiction Websites regarding specific offenders or with respect
to the omission of information about other offenders who may be residing, working, or attending school in the vicinity of any location that is the subject of
any search using this Website. In this regard, the Department accepts no responsibility or liability for damages of any kind resulting from reliance on this
information or lack thereof

It is possible that information accessed or obtained through this Website may not reflect current residences, employment, school attendance, or other
information regarding such individuals, and users are forewarned that it is incumbent upon them to verify information. Any user seeking more information
or verification should communicate with the responsible Jurisdiction agency and/or the local law enforcement agency where the offender resides, works,
or attends school, as appropriate. Any individual who believes that information contained in a Jurisdiction Website is not accurate should communicate

[l agree and acknowledge the terms of NSOPW

Please enter the code below and press Continue.

4. A list of Search Results will display. Click on the offender’'s name, if listed.

National Sex Offender Search

Resulls printiiew  create new search

600 ricacds fram & natiacal search including all st indian Gountry For First Nome e john, Last Nama it doe. To viow a kst of the

dod in this search, click harg
swd 22017 5.00 PM EST

Califomia. The jormdicon’s service & lemporarily unavaitable. Please bry again e
Mhississippl: The jursdizion’s senvice is lamporarsy unavatable. Piease iry agun later

OFFENDER +  AGE ¥ ALIASES @ ADDRESS %
. JAIME 39 INS CUSTODY
3 INCARCERATED,
| FL 00000
UNKNOWH
view sl &

.‘ . - , TALIB 63 Mis

WA WA 53713
DANE

viewgll *
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5. The Offender Detail Screen will display. Copy and paste the qualifying offenses
into the SOR tab in JARVIS System Checks.

Click Here to Track this Offender

Designation: | Sexual Offender

Mame: | JAIME

Status: | Supervised - FL Dept of
Comections

Department of | K70230
Corrections #: | Search the Dept of
Comections Website

JAIME ABRAN
Date Of Photo: 07/09/2008

Aliases
JIMINEZ, JUAM JAIMES RIVIERA, JUAN RIVERA, JUAN JIAMES RIVERA, JAIMES AERAHAM
Scars, Marks & Tattoos
Hone Reported

Address Information

Address Source Information Map Link
IS CUSTODY Source: Dept. of Corrections
INCARCERATED, FL DOOOD Received: 0672772014 Address not mappable
Unknown County Type of Address: Permansnt

years old by offender 18 years or odder;
F 5. B0 046
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IMPA

1. Access the IMPA home page by clicking on
https://secureapp.dhs.state.ia.us/impa/

2. Sign into IMPA by entering your username and password in the fields designated

above. Click Login.

Iowa Medicaid
Portal Access

teaister Hew Ascount Decuments

Wealcome to the Iowa Medicaid Portal Application! Helpful Hints.
Leoking for @ medicaid partcpating provider? Find one here, User Name:
Ba sure b find o of the latest Provider Information Letters haps. L
Passward:
My rvey finds many Amarican
Iminediate repoal (2 days aga} ~
According to a new national survey on Americans’ opinions on the Affordable Care fest Mgt
Act (ACA) conducted. ..
Click here for the
User Registration Guide i ;
e doctors
(6 days )]
kit oAy Proponents of repeabng the amm Care Aet, inchuding Prasident Donald
Trump's nodmee for Secr...
« Provider Enraliment Renewal
Prowder enrolment renewal is an Affordable Care Act (ACA) requirement for al arge pre-ACA Medicald expansion did no
provders in order o Slay actve with the IME. This includes provideds whe were Gancer surgery (7 days age)
previously enrolied with Magedan and who recently enrolled with the IME, The ACA An anatyss of the New York State's Medicaid exparsion, which predated the
requires that the IME renew enroliment of all providers, regardiess of provider types, a 2010 Affordable Care Act,..,
least every five years. Froviders who fail to complete enroiment renewal by December
31 2018, may be at nsk for having their Medicaid provider number suspended or
terminated If you have any questions regarding enrollment renewsl, please conlact the
IME Prewider Senvices Ui at 1-800-338-7908 (Option §) o by email al
IMEProviderEnrollmentEdhs state.ia.us Canvrls wccaunts for sty mora bosgital nd s
T R R L LR A R S S A than any of the fou...
H 1] ”
3. Select the Option of “I accept (Enter the system).
Ints
Welcome to the Towa Medicaid Portal F\P EI_EAVE THIS SYSTEM IMMEDIATELY if you do not agree to the following conditions: This h
|lowa Government information system is for authorized use only. Users have no expectation
of privacy. Any use of this system implies consent to monitoring of any and all activities
associated with its use. Unauthorized or improper use of the system may result in
administrative disciplinary action and appropriate civil and criminal penalties under
applicable law. Fe neEws
| 1 accept (Enter the system) | | 1 do not accept (Log me out) |

Click here for the
User Registration Guide

Featured Functicnality
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https://secureapp.dhs.state.ia.us/impa/

4. Hover over the File tab on the upper left hand corner and select MCO-Member
Lookup from the drop down menu.

Iowa Medicaid
Portal Access

File » Review Manage » Information »
MCO-Member Lookup)

5. Search for person by their Medicaid State ID (Same as SID) in the box provided
below.

Messages Logout

File » Review Manage ! Information » Messages Logout

On this page, you have the ability to search for a member and return information that is spec fiic to that member. You will only be able to search for Members that are assigned to your MCO.
Some of the returned items for this search are:

Medicaid State ID low a Medicaid identifier

Member Name MName of the member w ithin IME MMIS
Assigned MCO Assigned MOO

Status Tentative or Final Assignment

Additional Authorized Contact Name of a person, agency or facility that is allow ed to speak on behalf of the member.
Contact Modifier Identifies the relationship of the contact. (GDN: Legal Guardian, CSV: Conservalor, FOR: Protective payee, Other payee or Authorized representative.)

Documents that are currently available for the member w il be displayed in the "Documents” tab.
=If a Member is not found after searc hing for them, they could be:

* Not assigned or Tentatively assigned to your MCO
* Fee For Service
* Not an actively eligible Medic aid member

If you need to fill outan "Authorized Representative” document, it can be found atthe following link: http://dhs.iowa.qov/how-to-apply

search Criteria

Medicaid State ID: C] ‘)g Search Clear

t Iowa Department of Human Services

If you do not have the Medicaid State ID number, click the looking glass next to the
box to display the Advance Search Box.
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This facilitates search by SSN and/or the first name and last name. You must enter

at least two characters of the first and the last name.

L35t Name: |

Iy I Seareh for & sy Arse lame: | l VesrEsers that an
Jr this seanch s b )
pos: | 1=

oW 2 M i i
teare of fhe e

At s MOD Search Clear Close
Tenviaivee or Fral

htact Hame of A porscr
jdentd s the rei Ir payee o Antnoy

ssh: | ]

vl [of [Fe memsy

7 seac hing for them

ety assgned 1o youl

o Mo i e

mhorized Repres@ifitate” document, it can be haund a1 the folowang link. hitp:/ fdhs dowa.gov/ how-to-apply

| ')

Search Clear

Click Search to display a list of search results. From this list, select the appropriate
person by clicking Select. If they do not come up in the list of search results,
they have no history in IMPA. Document that into the designated look up

section*.

Advance Search

Last Name: |smith |

First Name: _john I

DOB: =

SSN: |

Search Clear Close

Showing 15 of 96 members found. Please select one OR refine
search to continue.

| StateID | __Name | Birth Date |

Select | 3mmwmD SMITH, JOHN 0%/06/207%
Select | OFWIC | SMITH, JOHN | 08/04/19%)
Select |SMITH, JOHN | 0" /0"/1987
Select | ORwm) | SMITH, JOHN | OB/ 14/1¢

Select 200 IH | SMITH, JOHN | #/15/19%
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6. The Member tab displays the assigned MCO for the individual searched.

On this page, you have the abilty to search for a member and return information that is specific to that member. You wil only be able to search for Members that are assigned to your HCO.
Some of the returned items for this search are:

Medicaid State ID lowa Medicaid identifier
Member Hame Name of the member within IME MMIS.
Assigned MCO Assigned MCO

Status Tentative or Final Assignment

Additional Authorized Contact Name of a person, agency or facilty that is allowied to speak on behalf of the member.
Contact Modifier identifies the relationship of the contact. (GDN: Legal Guardian; CSV: Conservator; FOR: Protective payee, Other payee or Authorized representative.)

Documents that are currently available for the member will be displayed in the "Documents” tab.
={f a Member ig not found after searching for them, they could be.

Mot assigned or Tentatively assigned to your MCO
* Fee For Service
Mot an actively eligible Medicaid member

If you need to fill out an "Authorized Representative” document, it can be found at the following linkc hitp: / /dhs.iowa.qgov/how-to-apply

Search Criteria

Medicaid State ID: 3 search Clear

Member | Demographics | Programs/Services | Fostercare | Documents  :ding..

ember Name
John Smith
Datsiak

07/06/20 Male

i MCO Status Beain Date

United Healthcare Plan Final 02/01/2017

United Healthcare Plan Final 03/01/2017
uthorized Contact Contact Modifier

Copy and paste the MCO that is assigned on the member tab into the
designated IMPA look up section*. This states who the person’s MCO is that is
assigned so then supervisors are able to forward intakes when needed to the correct
provider.

7. Find the services that the person is approved for by selecting the Programs/Services
Tab. The LTC Case Record will display the Income Maintenance Worker and
Community Base Case Manager details. Copy and paste the services into the
designated IMPA look up section*.

Search Criteria

Medicaid State ID: I:l Q Search Clear

Member | Demographics | Programs/Services _hzuments

Medicaid Program

gram Code ram Descri Program Status  Progral

Prog Program Description ogram Effective Date
640 Ssi Related Medical (D Mandatory Supplement) Active 01/01/2017

Long Term Care/Enhanced Services

Program Description Program Status Program Effective Date  Medical Review Date
Habilitation Services Approved 06/01/2016 08/17/2016

* On a child abuse intake, this lookup information should be documented on the Intake
Information screen in the field labeled “HISTORY OR KNOWLEDGE OF LANGUAGE
BARRIERS/DISASABILITIES.”

* On a dependent adult abuse intake, this look up information should be documented
into the IMPA look up section.
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